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Altsys Corporation License Agreement

Bv opening the sealed package containing the master disks. you are agreeing to be bound by the terms of this
license agreement and limited warranty. If you do not agree to the terms of this agreement, promptly return
this unopened disk package and all other materials in this product to the place from which you obtained them
for a full refund

Warranty Information

Altsys Corporation ("Altsys”) warrants to the original purchaser of this software that (1) this software will
perform substantially in accordance with the accompanying written materials, when used with the recom-
mended system configuration; and (2) the disk or disks upon which this software is recorded are not defective
and have been propetly recorded This warranty is for a period of %0 days after the original purchaser’s
purchase of this package, during which time any disks which become defective under normal use will be
replaced at no charge The product warranty card should be registered with Altsys in order to provide proof of
original purchase. Altsys' entire liability under this limited warranty and otherwise with respect to the
software, is limited to return of the software and accompanying materials to the dealer or to Altsys for
replacement or refund, at Altsys' option. ALTSYS DISCLAIMS ALL OTHER WARRANTIES, EITHER
EXPRESS OR IMPLIED INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MER-
CHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. ALTSYS DOES NOT WARRANT
THAT THE FUNCTIONS CONTAINED IN THIS SOFTWARE WILL MEET YOUR REQUIREMENTS
OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE. IN
NO EVENT SHALL ALTSYS. ITS SUPPLIERS. EMPLOYEES, OFFICERS, DIRECTORS. DEALERS, OR
DISTRIBUTORS BE LIABLE FOR ANY DAMAGES. INCLUDING LOST PROFITS OR LOST SAVINGS
OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES, ARISING OUT OF THE USE, IN-
ABILITY TO USE, OR ABUSE OF THIS PRODUCT, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY. SOME STATES DO NOT ALLOW
LIMITATIONS OF IMPLIED WARRANTIES, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES,
SO SOME OF THE ABOVE LIMITATIONS MAY NOT AITLY TO YOU.

Copyright

This manual and the accompanying documentation are copyrighted. You may not distribute copies of this
software or accompanying documentation in any form without prior written consent from Altsys Corporation

OTHER RESTRICTIONS. You may not rent, lease, or sub-license the software or accompanying documen-
tation. GENERAL. This agreement is governed by the laws of the State of Texas.

US. GOVERNMENT RESTRICTED RIGHTS. This software and documentation are provided with RE-
STRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions as set forth
in paragraph (c)(1Xii) of The Rights in Technical Data and Computer Software clause at DFARS 252.227-701 3
Contractor/manufacturer is Altsys Corporation, 269 W Renner Road, Richardson, TX 75080,

Trademark Information

Fontastic and Family Builder are trademarks. and Fontographer and Metamorphosis are registered trade-
marks of Altsys Corporation. MultiFinder. and Finder are trademarks of Apple Computer, Inc. Apple, Mac,
Macintosh, LaserWriter, ImageWriter, and AppleTalk are registered trademarks of Apple Computer, Inc.
Streamline is a trademark and PostScript and [llustrator are registered trademarks of Adobe Systems, Inc.
FreeHand is a trademark and PageMaker is a registered trademark of Aldus Corporation. Microsoft is a
registered trademark of the Microsoft Corporation. MacDraw | and 1 are registered trademarks of CLARIS
Corporation. TypeStyler is a trademark of Brederbund Software. Inc. Forever and Treacyfaces are trade-
marks of Treacyfaces, Inc. Master Juggler is a registered trademark of ALSoft, Inc. Suitcase 11 is a registered
trademark of Software Supply.
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CHAPTER ONE

| Metamorphosis Professional

4 . "
4" Metamorphosis® was the first product to allow you to convert your

Type 3 PostScript® language typefaces into Type 1 (Adobe Type Man-

ager™-compatible) fonts and also convert your Type 1's into Type 3's.
._ 4 Metamorphosis Professional version 2.0 expands those original capabili-
o ties to provide you with all the features you need to keep up with the

advances of today’s exciting new font technologies.

With Meta Pro, vou now have the ability to convert an entire character
set or specific lines of text to PICT and EPS format for use on the
Apple® Macintosh®. So now, instead of being limited by what you can
do with your text in drawing programs like Canvas™, MacDraw®, and
Aldus SuperPaint®, you can treat your type just like any other graphic
image. Fill your characters with checks, stripes, dots, change their line
sizes, and stretch and manipulate their outlines,

[ook what y@u
carn: 4o NOW!

Metamorphosis Professional (or Meta Pro) also gives you the ability to
convert your fonts into TrueType™ for the Macintosh or IBM-compat-
ible personal computers (PCs). TrueType is Apple’s outline font format
that can be used with System 7 operating software and versions of
Microsoft Windows which support TrueType. What makes TrueType
unique is the fact that it can be used for both the screen display and
printing, eliminating the need to have two font files for each typeface.
Those of us who have invested heavily in PostScript typefaces don't
have to despair or be left behind. You can now convert all of your
PostScript typefaces directly into TrueType with Metamorphosis!

METAMORPHOSIS Professional 1




Metamorphosis Professional converts vour fonts into:
PICT and EPS outline formats tor use on the Macintosh:

TrueType tonts for the Macintosh and IBM-compatible personal
computers;

Type 1 PostScript fonts for the Macintosh, for IBM-compatible PCs
running ATM under Windows 3.0. and for the NeXT®,

Type 3 PostScript fonts for the Macintosh and the PC; and
Fontographer® database tiles, which can be used in Fontographer

to create custom type for the Macintosh, IBM-compatible PCs
using Windows 3.0 running ATM., and NeXT computers.

Before you begin
What do you need to get started?

Betore you actually start using Metamorphosis Professional. check to
make sure your package is complete. Your package should include the
Metamorphosis Proftessional "Program disk” and the User's Guide.

You must have a Macintosh Plus (or higher) computer with at least 1
megabyte of RAM. Metamorphosis Professional can run on a single
floppy drive system (with some inconvenience), a two floppy drive
system, or a system with a hard disk (recommended).

The System file on your disk should be version 6.0.4 or later, and the
Finder should be version 6.1.4 or later.

2 METAMORPHOSIS Professional



Backup your Metamorphosis Professional disk

Before you do anything else, turn your disk over so the back side faces
you and push the black tab up so you can see through the write-protect
opening. This will prevent you from accidentally erasing any informa-
tion while you make backup copies. You should immediately make a
copy of the Metamorphosis Professional master disk for a backup copy.
Find a blank disk and copy Meta Pro onto it by dragging its icon onto
the blank disk's icon. Change the disk if requested. You should now use
this new disk and store the original Metamorphosis Professional "Pro-
gram disk” in a safe place.

Read me...

All Altsys release and update disks contain a TeachText document titled
‘ReadMe.” This document contains information about the product
which may not be present in the User's Guide. You should read this file
before artempting to use the program.

Register for technical support

Altsys believes in customer support and wants to resolve any problems
you have.

To become a registered user and to receive technical support, notifica-
tion of product upgrades, and other news about Metamorphosis Profes-
sional and Altsys, you must complete and return the registration card
included in this package.

Our support lines are available on business days, Monday through
Friday from 9:.00 AM to 500 PM Central Time. Our support phone
number is (214) 680-2093. Please have your serial number on hand

when you call. Your serial number is located on the back of the "Program

disk.”

You can also receive more information on Compuserve: GO
MACBVEN, data library 3, Subtopic #3. On America Online, type
Command-K and enter the name Altsys.

METAMORPHOSIS Professional 3




The remainder of this section tells you how to begin using Meta Pro.

To install Meta Pro:

You can see the application icon on the Metamorphosis Professional

disk.

=\ rro

Metamorphosis™ Professional

+ If you have a hard disk, create a file folder on it by choosing
"New Folder” from the File menu.

+  Change the name of the "Empty Folder” to a name like "Meta
Pro” or some other name that makes sense to you.

Note: If you are running System 7, this folder will be named
something different, like "Untitled folder.”

+  Drag the Meta Pro application from its diskette into the new
folder you just created.

That's all there is to it! You've just installed Metamorphosis
Professional.

METAMORPHOSIS Professional



Using Metamorphosis Professional

To start Meta Pro:

+  (Click on the Meta Pro icon.

=|Fro

Metamorphosis™ Professional
+  Choose "Open” from the File menu.
OR (the preferred method)
+  Double-click on the Meta Pro icon.

Metamorphosis Professional will display an opening screen that
contains copyright and version information.

FONT CONYERSION UTILITY

Version 2.03

Written and developed by
James Brasure, Pete Mason, Jim Yon Ehr,
Tom brby , David Spells, Parry Kejriwal, and Kevin Crowder
Special thanks to PostSoript wizard Harvey Grosser

Yerswn date | August 25, 1991
Memory available: S69K
Machine: Macintosh 1k
& 1991 Altsys Corporation System version: 7.0.0

METAMORPHOSIS Professional ..




After a brief pause, Metamorphosis Professional’s main window

appears. The main window is where you choose all your conversion
options.

The main window

You can move the main window by clicking on its title bar with the
selection pointer and dragging it.

ED========== Metamorphosis Professional ===

@® Convert tent ) Convert fonts |:ii pongert.., 1#:5:]

(< Display selected font

Format:| PICT to clipboard v | <>

Font: | Times e v |

Style: __Roman

Size: W‘T_I

Teut: Type your own v

&

s oy G o et

The first time you open Metamorphosis Professional, the "Convert text”
mode will be checked in the main window. From then on, whenever

you open Meta Pro, the mode you last used will be active. This is due
to the fact that Meta Pro automatically places a preferences file in your

System Folder.

Metarmorphosis Prefs

METAMORPHOSIS Professional



The file is named "Metamorphosis Prefs” and is responsible for saving
information about Metamorphosis Professional’s conversion modes. With
the preferences file in your System Folder, it is possible to open Meta
Pro with the same settings and mode you last used Meta Pro also
remembers your output formats.

So if you used the "Convert text” mode the last time you used Meta
Pro, the program automatically remembers the output formats and
options you selected. See page 57 for more detailed information about
the Preferences file.

Conversion modes

After you open Meta Pro, the first thing to do is decide which mode
you wish to use. Do you want to convert text to PICT or EPS format? If
s0, you choose the "Convert text” mode. If you want to convert fonts to
other font formats, choose "Convert fonts.”

The first conversion mode we will discuss is "Convert text.” If you want

to begin converting fonts, go directly to Chapter Three which begins
on page 33.

METAMORPHOSIS Professional | 7



Quitting Metamorphosis Professional

To quit Meta Pro:
+  Choose "Quit” from the File menu or type 3#Q to exit the
program.
OR
+  Click on the close box.

= Metamorphosis Pr

@ Convert text O Convert fonts

X

Format:| PICT to clipboard *r|
Font: Times 'r|

Style: Roman v |

Size: 100 || w»

Teut: TH[IE your own ¥ |
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.....

3,

6.

Convert text

CHAPTER TWO

" This mode allows you to convert to paths (or outlines) whatever text
& appears in the text edit box. The most important aspect of this mode is
| that you have the ability to type in the text you want to convert.

4 Five options are provided in the "Convert text” dialog: Format, Font,
4 Style, Size, and Text. You can change any or all of these options as you
use the program. There are six basic steps in the "Convert text” mode.

Select (or type in) the text you wish to convert.
Choose the format you wish to convert to.
Choose your font.

Choose your font style.

Choose your font size.

Convert.

Converting text into PICT outlines is so simple that we will show (on
the next three pages) how to convert a phrase into a PICT outline and
"Paste” it into MacDraw. If you don't want to participate in this exer-
cise, you can proceed directly to page 12 for more detailed information
about each of the "Convert text” options.

+  Double-click on the Meta Pro icon to open the program.

=|Fre

-

Metamorphosis™ Professional

METAMORPHOSIS Professional 9
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The first time you open Meta Pro, the "Convert text” window is active
and (if you have Times-Roman installed) all the modes appear identical
to our example window.

If you don't have Times-Roman installed you can:

+  Drag through the "Font:" menu to select another font.

- L
TRIGoud bs Professionol S g
TFForever
® Conud 1o itat (Convert... %6
::1!:“““” Pisplay selected font
. any
Farmat: imes L
ctule: | TMFont s
- Trump Mediaeval
Size: Typestylefont
| TypeTermFom
Tewt: | unwers ss

+  Type "It’s easy!” in the text edit box on the right.

e Metamorphosis Professions) Ee—— 1]

@ Convert text ) Convert fonts

[ Display selected font

o |
= It’s easy!

Tent: | Type your own v |

+  Press the "Convert” button.

selected font

S easy

&
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A dialog box shows which font is being generated. Its progress bar
shows how the font conversion is progressing. The pie graph on the
right shows the portion of time that has elapsed in the overall font

CONVETSION Process.

’m Converting Fonts T T

Reading “Times-Roman” (Type 1) from disk.

| —

[Stnp H.]

When the font is finished converting, since Meta Pro automatically
places your PICT into the clipboard, you can paste your PICT file

directly into MacDraw (or another drawing program).

Note: If you are running under MultiFinder or System 7, you can have
Meta I’ro and your drawing program open at the same time.

+ "Paste” your newly converted PICT file into your drawing

program. Our example is in MacDraw 11.

i

METAMORPHOSIS Professional
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« Now vou can select one or several characters, fill them with
patterns, change their line sizes, or use the "Reshape” tool to drag
the points.

It’sEasy!

You see how simple that was? Go ahead and experiment, the sky's the
limit!

Convert text options

Format

PICT file

/PICT to clipboard ..

The "Format” option allows you to convert your text to a PICT file, a

PICT that will be saved in the Clipboard, or an EPS file.

PICT file

The "PICT file" option is provided to generate PICT format files.
Metamorphosis Professional creates an object-oriented PICT that stores
the points and paths of the characters.

12 METAMORPHOSIS Professional



Programs such as MacDraw and MacDraw II, Canvas, Cricket Draw,
DeskDraw, and Aldus FreeHand can read this file format directly for
editing purposes. So now you can fill your characters with specitic
colors or patterns, reshape, distort, or enhance them, and even change
their line sizes.

Metamorphosis Professional automatically retains the kerning of any
tonts that it converts to PICT and EPS. The illustration below shows

the difference between text typed in MacDraw Il and a Meta Pro
PICT file opened with MacDraw 1l.

1M r I )
Typed text Pasted PICT outlines Pasted PICT outlines
(not kerned) (kerned) (filled and kerned)

Remember also that the characters in the middle and right-hand side
are outlines, so you can edit them and apply whatever tills or patterns
you choose.

Note: PICT outlines are not always absolutely identical to their PostScript
counterparts; there is a small amount of approximation involved in the
conversion. For more information about PICTs, see page 29

Meta Pro offers you the option of choosing a file name and choosing
where you would like it stored when you press the "Convert” button.

This is explained in detail on the next page.

A converted TimesRoman font could be named "TimesRoman.pict’
and look like the document icon below.

2

TimesRoman pict

METAMORPHOSIS Professional 13
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To name a PICT file:

When you "Convert” font outlines to a PICT file, Metamorphosis offers
you the option of naming it yourself or with the default name Meta Pro
provides,

+ Type the new name in the "Save"” dialog box.

‘3 My Greatest Software

(O Metamorphosis Profely] = Hard Disk

(2 Fontographer -

[ The Art Importer [ _Efeet
[ Drive |

(2 Family Builder
[ Fontastic Plus
(2 Aldus FreeHand

Save the file as: | Save ]

(Cancer)

+  Click the "Save” button.

Note: If you already have a PICT file named GoudyOldstyle.pict
in the folder that you generate to, Meta Pro will ask you to rename
your new file.

PICT to clipboard

[f you choose the "PICT to clipboard” option, the PICT file is automati-
cally stored in a holding place known as the Clipboard. You should
Paste” it into another application (or your Scrapbook) immediately
since the next item that is converted or copied to the Clipboard will
replace the PICT you just put there.

METAMORPHOSIS Professional



To convert PICT to clipboard:
+  Select all your options, like font, style, and size.

+  Convert your characters by pressing the "Convert” button, or by
typing #£G.

OR

+  Choose "Convert. .." from the File menu.

Open font file... 30
Bpen installed fants.., =F

Preferences... *EP

OQuit #0

If you are running under MultiFinder or System 7, you can have Meta
Pro and vour drawing program open at the same time.

After you convert your characters you then:

+  "Paste” your newly converted PICT file directly into your drawing
program, which in our example is MacDraw 1.

CI

F1ll and stroke
your outlines...

Wi /10]010}/ >
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+  Click on one or several characters and select a pattern or fill.

T N Y

Fill and stroke
your outlines.. .

Note: PICT outlines are not always absolutely identical to their Post-
Script counterparts; there is a small amount of approximation involved
in the conversion. For more information about PICTs see page 29.

A
~
-
=
o
i |
“T
&

If you are running under the Finder, you can only have one program
open at a time. You can copy your PICT file into your drawing program
one of two ways.
+  Choose your options and convert your text.

Metamorphosis Protessional stores the PICT file in your Clipboard.
+  "Quit” Meta Pro.
«  Open your drawing program.
+  Choose "Paste” from the Edit menu.
+  Your PICT file is pasted into your drawing program's work area.
OR

+  Paste your PICT file directly into your Scrapbook after you

convert your fonts.

«  "Copy” the PICT file from the Scrapbook and "Paste” it into
your drawing program whenever you like.

METAMORPHOSIS Professional



The "EPS file” option generates an Adobe [llustrator® 1.1-style EPS
(Encapsulated PostScript) tormat file. Programs such as Aldus
FreeHand® and Adobe Illustrator can open this file format directly for
editing purposes. And once you open your EPS file, you can add or
delete points, reshape, distort or fill characters with a specific color or
pattern, or change the stroke weight. You can even alter a character’s
shape to create swash caps.

Even though the current versions of FreeHand and Illustrator have a
command for getting font outlines themselves, they cannot convert all
kinds of fonts, such as fonts that reside only in the printer, TrueType
fonts, and some Type 3 fonts. With Metamorphosis Professional, you are
assured of getting the outlines from Type 1, Type 3, and TrueType into
both these programs.

When you generate an EPS file, Metamorphosis Professional allows you
to choose your own file name.

To name an EPS file:

When you press the "Convert” button. this dialog box appears.

| My Greatest Software ’

| (0 Metamorphosis Profetlr] < Hard Disk
(2 Fontographer —
(3 The Art Importer [ _Eject ]
(2 Family Builder (" Drive )
[0 Fontastic Plus
2 Aldus FreeHand
Save the file as: |_Save |

limesRoman.pict [ Cancel ]

METAMORPHOSIS Professional 17
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+  Type the new name in the appropriate box.

+  Click the "Save” button.

Note: If you already have an EPS file with the same name in the

folder that you generate to, Meta 'ro will ask you to choose a new
file name.

If you name your file "TimesRoman.art” it will look like the Adobe
[llustrator 1.1 document icon below.

2

TimesRoman.art

If you don't have Illustrator 1.1 anywhere on your system, your icon will
look like the generic blank page icon below.

B

TimesEoman.art

METAMORPHOSIS Professional



Font

s

Fractions
Freestyle Script
Garamond
Garamond-Bold

Font: ] voudyoldstyle
GoudyTall

GoudyTallBold
GrammarianSampler
H Tiffany Heauwy

HI Tiffany Heavyltalic
Helvetica

The "Font™ popup menu allows you to select the typeface that you'd like
to convert to PICT or EPS format.

All your installed outline fonts (PostScript or TrueType) will be listed in
the "Font™ popup menu. This means that bitmap fonts like Geneva and
Chicago will not appear unless they have TrueType outlines available to
them. You select a font the same way you select other popup menu
items: by holding down the mouse button and dragging through the
font menu. An arrow at the top of the font menu indicates that there
are more fonts listed above the first font in the list.

Note: Changing the font automatically changes all the text in the edit
box.

Open font file...

The "Open font file...” option is provided to allow you to open a font
you have stored in a specific folder or location different from those
installed in your System file. In this instance, the following procedure
will open that font file.

METAMORPHOSIS Professional 19
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To open a font file:

Open font file...
Spen instaliad (ands...

+  Choose "Open font file..."” from the File menu or type ¥#O.

This presents the standard file selection dialog, which allows you to
choose a bitmap font file, a Fontographer outline source file, or a
TrueType suitcase from the folder in which it is stored. The file
selection dialog works in the standard fashion, so vou can change
drives, eject disks, open a file, or cancel.

= |

% Garamond
D Garomond omer . SEY IR
O Garamond Plain
[ Eject ]
[ tvive |
( Open |
G| [ _Cancel ]

+  Choose the font file you wish to open by clicking on its name.
+  Click the "Open” button.

Meta Pro places all the fonts from the file you select into the "Font’
popup menu.

Font: B Garamond Bold *r|
Style: Bold -rl

METAMORPHOSIS Professional



If there is more than one font or style in the tont file you select, you
will be able to select all of them in the "Font”™ menu as shown
i"l'if.']l'ﬁ'\»'.

Font:

Bl Garamond Boldltalic
Garamond
| Garamond Lightltalit

Style

Italic
Boldltalic

The "Style" popup menu allows you to select the style of the font that
vou'd like to convert to PICT or EPS format. This menu will vary
depending which tont vou select.

Only style variations associated with the chosen font family will be
displayed in the "Style” menu. You select a style the same way you select
any other popup menu item: by holding down the mouse button and
dragging through the "Style” menu.

If you change the font, the style menu will also change. For example,
selecting Times will change the "Style” menu to list Roman, Bold, Italic,
and Boldltalic.

Font: Times v |

Size:

Bold
Italic

Tent: | Boldlitalic tl‘l w

METAMORPHOSIS Professional 21
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But selecting Stencil, for example, will change the "Style” menu to show
only Plain. That is because Stencil is available only in the Plain style.

Font:;

Stencil 1r|

Style: |l v Plain §

Size:

100 ~r|

Teut: Tgpe your own "r|

Some fonts have styles with unusual names. In addition to the standard

Plain, Bold, Italic. and

Bold Italic, be prepared to see names like

Demiltalic, Oblique, BoldOblique, LightOblique, Black. BlackOblique,
Demi, DemiBold, Serif, SerifDemiBold, Serifltalic, SerifDemiltalic, Light,
Lightltalic, Book, Condensed, and even Laser. Some names indicate
the same style. For instance, Italic and Oblique usually are the same on

the Macintosh.

Note: Changing the style automatically changes all the text in the edit

box,

The "Size" popup menu

36
48
12
96
100 2
120
150
200
250
300
400
500

allows you to select the size of font that you'd

like to convert to PICT or EPS format,
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Meta Pro automatically displays twelve point sizes in the “Size:” menu.
The point sizes Meta Pro displays are larger than most size menus due
to the way PICT images display text. You'll get better results if you need
small point sizes by generating a larger size PICT than what you
actually need, and then scaling it down in your drawing program. For
example, if you need a 24 point PICT, generate it at 96 points and then
scale it down to one-fourth of its original size. If you want a 96 point
PICT, however, you can generate one right at 96 points because that is
usually large enough for PICTs to do a good job. Refer to "Things you
should know about generating PICT format files” on page 29 for more
detailed information about this.

You select a size the same way you select any popup menu item: by
holding down the mouse button and dragging through the "Size” menu.
To enter a size other than those displayed, simply type the number into
the size box directly to the right of "Size:" You can enter and convert
point sizes between 1 and 1000. However, the largest size that will
display in Meta Pro’s text edit box is 72 points.

Note: Changing the size automatically changes all the text in the edit

box.
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Text

First 128 chars
Uppercase
Lowercase
From a file...
Type your own

The “Text” popup menu determines what text appears in the text edit
box. Choosing a new option causes the text currently in the edit box to
be replaced by the text that the new option specifies.

All characters

11111117 111 s
IRERERRRRRRERRRERE

"#8%&'()*+,-./0123456789: ;<=>7@ABCDEFC
HIJKLMNOPQRSTUVWXYZ[\]* “abcdefghijk
Imnopgrstuvwxyz{ |} ~] AACENOUaadadacéeeei
iiifiooooduutint ¢LSBE® O™ £ £Deot <>¥udl
Qo ;v fxAw... AAOEe-—"""+dyY
loofifit-,, % AEAEEINNOO®OUUU " ~ =

i S i i

The "All characters” option is provided for instances where you want to
convert all 256 characters in the font.

Note: Brackets or squares at the beginning of the character set repre-
sent characters (control characters, for example) that don't contain an

image.
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First 128 characters

1111111 111
BRERRERRERRRRRRRE |
"% &' () +,-./0123456789
<=>7@ABCDEFGHIJKL
MNOPQRSTUVWXYZ[\]*
_abedefghijklmnopqrstuvw

xyz{|} -]

The "First 128 characters” option is provided for instances where you
want to generate fonts containing characters 0-127 (punctuation char-

acters, the standard upper and lowercase characters, and the numbers 0
through 9).

These are the characters you will usually be interested in. This choice
will not include the European accents and symbol characters. This
option would also be a good choice if storage space is a consideration.

Uppercase

ABCDEFGHIJKLMNOPQ/[
RSTUVWXYZ

The "Uppercase™ option is provided for instances where you want to
generate only the uppercase characters in your typeface. When you
select this option, all the uppercase characters in that particular type-
face are displayed in the text edit box.
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abcdefghijklmnopgrstuvwx [&
VZ

The "Lowercase” option is provided to generate only the lowercase
characters in your typeface. When you select this option, all the lower-
case characters in that particular typeface are displayed in the text edit
box.

From a file...

The "From a file...” option is provided to allow you to import a "Text

only” file from applications such as Microsoft® Word, MacWrite®, and
TeachText.

+  Choose "From a file...”

This presents the standard file selection dialog, which allows you to
choose a text file (to read into the text box). The file selection
dialog works in the standard fashion, so you can change drives,
eject disks, open a file, or cancel.

&3 Current Pro IEﬂi

1 Meta Pro Texl
2 Family Builder
O Fontastic Plus
O Fontographer
3 The Art Imporier
2 Aldus Freedand
3 My Tent Tiles
3 My Art Work
O Ildlmrtislng

Select a file to read into the text
bowu:

e Hard Disk

| Eject |
[ Drive |

| oOpen |
| cancel |
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When you choose the file, Meta Pro displays the text in the text edit

box.

o

With Meta Pro, you now
have the ability to
convert an entire
character set or specific

text to PIC'T and EPS

format for use on the
Macintosh

o
&)

Note: You can change text files simply by clicking on "From a file.. .’
again and selecting another text file.

Type your own

The "Type your own” option allows vou to determine the text that
Metamorphosis Professional converts. To utilize this option, simply type
the text you wish to convert in the Meta Pro text edit box.

] Display selected font

This box is known as the [
“Text edit box.”
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The text edit box is directly below the "Display selected font™ checkbox
and is always displayed when the "Convert text” option is checked. The
text box supports all the standard Macintosh editing features, including
"Cut,” "Copy,” "Paste,” and "Clear.”

The first time you see the text edit box, it will be empty. Once you
select a font and either type in text or select a different option from the
“Text” popup menu, it will contain text. Additionally, the Metamorphosis
Preferences file insures that the text displayed in this box will also
appear the next time you use Metamorphosis Professional.

A standard scroll bar is drawn along the right side of the text edit box.

By moving the scroll bar, you can view long sections or large sizes of
text.

Display selected font

By checking this option, Meta Pro displays the text edit box in the
actual font. style, and size (up to 72 points) selected. It this box is not
checked. or if the bitmap file is not available, the text will be shown in
Chicago 12-point.

(<] Display selected font [ Display selected font

With this option g B bl oo e
checked, this
window displays the
text in the selected
font, size, and style.

&

& 5

Note: Not displaying the selected font can be useful in instances where
you are converting larger point sizes that need to be scrolled to view.
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Things you should know about using
the PICT format

Although many programs read the PICT format, some programs do it
better than others. Among drawing programs, MacDraw I, Canvas 2,
and FreeHand 3 seem to be among the most trouble-free. If the program
you use to open PICT files or paste PICT images into seems to exhibit
problems (such as crashes, hangs, or missing data), there are several
things you can do.

First, don't give your program too much text at one time. PICTs will
work best with as few words used at one time as possible. So if your
program crashes when you attempt to paste in 100 letters, try to convert
and paste in the same text ten letters at a time. Then you can position
them properly once they have all been pasted in. In addition, some
programs don't do too well with pasted PICT images, but will open a
PICT file reasonably well. If you are having difficulties pasting in
PICTs, try creating a PICT file rather than using the clipboard.
Unfortunately, a few programs are simply unable to render pasted
PICTs smoothly. Hopefully, you can try a different program if you are
dissatisfied with a particular program’s ability to render PICTs.

When you are generating PICT autlines, think BIG. Due to the nature
of PICTs, small point sizes will not faithfully depict the original charac-
ter outlines. In general, sizes below 72 points will not look right. In some
cases they may look good enough, but in other cases they will be
unacceptable. Try generating a 12 point sample, and you'll see what we
mean. Happily, most every program that accepts PICTs allows them to
be smoothly scaled. So if you really need a good-looking PICT at 12
points, generate one at 48 points, paste it into your graphics program,
and scale it down to 12 points. If that still doesn't look acceptable, try
generating at 72 points, or even 96 points. Don't be afraid to even try
sizes like 300 or 400 points; sometimes that's what it will take to get
great looking outlines. By trying a few different combinations of sizes
and scales, you will find a solution which looks great. In contrast, EPS
files look and print well at any point size you specify.
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[t you want the text Meta Pro generates to look just like regular text
once it's in a graphics program, there are a couple of things to be sure
to do. Let’s say that you want to use text from Meta Pro in your
MacDraw illustration, maybe so you can get properly kerned charac-
ters, or because you need type that's larger than 127 points. The best
time to make adjustments is immediately after pasting the outlines into
a graphics program because everything is automatically selected for
you. Text is pasted in with no fill, and a black outline. First choose a fill
of black (assuming you want black text). Then, with everything still
selected, remove the outline by choosing a pen size of zero. If the
outline is not set to zero, the characters will appear bolder than they
should. This is useful for special effects, and you can get all sorts of
interesting results using different pen sizes.

But for now let’s say you want your outlines to look like regular text. At
this point, you might have something like this:

PICT outlines-Layer#1

i (BT T NN BN S e i
Wew? Quitlines
O -

2

E 1canfill?

100

You can see that all the holes are filled in. This is because MacDraw Il
doesn't support what's known as "composite paths,” which are what
character outlines really are. To get around this, you need to select the
paths which represent the "holes” in the characters, and fill them with a
background color or pattern. That creates the illusion that you can see
through those areas.
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All you have to do is make sure nothing is selected, then click on the
top "hole” in the "o." It becomes selected, so vou can then fill it with

Wow? @utlines
1canfill?

If the outer outline of the "o" became selected instead. use the com-
mand "Move To Back” in the Arrange menu. Then click in an empty
area so that nothing is selected, and then click in the "hole” again. This
time it should become selected

Once you select and fill all the holes with white, you'll see something

like this:

Wow? Outlines
1 can fill?

If you are converting a bunch of words, or a few words at a large size,
you might be interested in word wrap. Meta Pro will automatically start
placing letters on the next line when the current line of characters gets
wider than three standard pages. Usually this isn't a problem, since you
can move and reposition the outlines any way you choose, If you are
worried about line endings, place carriage returns where they ought to
go when you enter your text into Meta Pro’s text edit box. Then the
line won't get so long that Meta Pro will have to wrap it
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One final note: Although Meta Pro gives you the ability to convert the
characters in a text file to a PICT, you should use this function with
care. If you convert an entire page of small text to PICT, chances are
that no graphics program will be able to accept it. Try to convert only a
couple of lines of text at a time, and you will have a much higher rate of
success. This isn't really much of a hindrance, since usually you will
need only a few characters, or maybe just a headline, in PICT format.
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CHAPTER THREE

The "Convert fonts” mode allows you to convert fonts into ten different
e output formats.

[E[J=======—=—== Metamorphosis Professional

() Convert tent @ Convert fonts [!: pnuert.., :-:i;]
Computer Type Fonts to Convert

Output Formats Mac PC NeXT

Type 1 PostScripte | 0 O O ot

Type 3 PostScript® | [0 O

TrueType™ 11 [

PICT file []

EPS file L]

Fontographer file ]
o
=

There are three basic steps in the "Convert fonts” mode.
1. Select your font(s).
2. Choose the font formats.
3. Convert.

Yes, it's that simple! You can convert and be using a font in five minutes
or less!

MEJAMORPHOSIS Professional 33



Before you can convert fonts, you must select the font(s) you want to
convert. Since fonts can be generated individually or in batches, you
can select as many as you like. Keep in mind that the time of the
generation process will vary according to the number of fonts and
options you select.

Which fonts do you select?

34

Meta Pro allows you to select a font by choosing its bitmap or TrueType
font file or Fontographer database file. The name of the printer font file
is stored in the bitmap font, thus linking the bitmap font to its corre-
sponding PostScript printer font file. We recommend that your PostScript
and bitmap files be in the same folder. Your PostScript files can also be
in your System folder. If a bitmap font does not have a related outline
file, you will not be able to generate the font unless it is already resident
in the printer.

In instances where PostScript fonts are built into the printer or are on
the printer's hard disk. having the PostScript file is not necessary.
However, if the PostScript font is not in the printer or the printer’s
hard disk, it must be stored in the same folder as its bitmap font file or
in the System folder.

You can add Fontographer 3.0 (and above) outline font database files to
the font conversion list with the "Open font file...” item in the File
menu. You can open all of your installed fonts by using the "Open
installed fonts...” item in the File menu. This includes fonts installed
with Suitcase [I® or Master Juggler® (or similar programs).

Note: Type 1 specifications restrict Meta Pro from generating Type 1

fonts that contain stroking or grayscale fills. Fonts created with Altsys
Art Importer cannot be converted because of this restriction.
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To open an installed font:

+  Choose "Open installed fonts. ..” from the File menu or type 3£F.

Open font file...

Praferanrpc WP

This presents the "Select Fonts” dialog box which allows you to
choose any font installed in your System file or fonts installed with
Suitcase [I, Master Juggler, or programs like them.

[ —— "Ry - —————

FreestyleScript
Garamond-Bold
baramond-Bolditalic
Garamond-Light
Garamond-Lightitalic
boudy0idBold
GoudyDidBoldi tal
GoudyDidital
boudyDidstyle
boudyTall
GoudyTallBold
brammarianSampler
Helvetica

r [ cancel |

A [ AN ".Hﬂuj
!;- (None N |

All your installed PostScript and TrueType fonts are listed in the "Select
Fonts” dialog. You have the option of selecting one, several, or all fonts
from this dialog.
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To select a font:

+  Click on its name and then click the "OK"” button.

OR

+  Double-click on its name to select a single font and close the
"Select Fonts” window.

To select more than one font:

+  Hold down the Shift key while you make your selections.

E=——————= selectfonis 5==—————2

Garamond-Bold
Garamond-Boldltali
baramond-Light
Garamond-Lightltali
Elll:lllulllllﬂtlld
GoudyDidBoldital
GoudyODidital
GoudyODldstyle
GoudyTall
GoudyTallBold
Grammariansamplen
Helvetica

+  You can also select all the fonts by clicking the "All” button or by
typing 4EA.

The font name(s) vou select will appear in the Meta Pro font list. Shift-
clicking on a selected font deselects it,

Note: Your original fonts will not be affected by this process since you
are merely accessing that font’s information without making any changes
to the original file

The next section describes how to select fonts which are not installed.

If you do not wish to add these fonts to your conversion list, you can
proceed to page 40,
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To open a font file:

You may have your fonts stored in specific folders or locations different
from those installed in your System. In this instance, you would follow
this procedure to open a font file.

+  Choose "Open font file...” from the File menu or type 3£O.

Open installed fonts...

Preferenrpes ... H P

This presents the standard file selection dialog, which allows you to
choose bitmap font files, TrueType suitcase files, and Fontographer
database files from the folders in which they are stored.

3 Fonts 1 | “
3 FOGFont — Hard Disk
O Freestyle Script
™M Friz [ kjact ]
(0 Garamond (" Drive )
(O Mistral & Reporter
2 SanSerif
2 Scanned Fonts [ open |
3 Stencil
[ Stones __Cancel |

Open a bitmap font file,

Fontographer® database file, or
TrueType™ suitcase file.
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Meta Pro will list only associated PostScript or TrueType fonts in the
file you open. You have the option of selecting one, several, or all fonts
from the "Select Fonts” dialog.

+  Choose the font you wish to open by clicking on its name.

=————=—selectFonts =ctv—m— ———
Garamond-Bold <3
Garamond-Lightitalic
(AN %A |
(None #N ] |
&

You can select more than one font by simply holding down the Shift key
while you make your selections. You can select all of the fonts by clicking
the "All” button or by typing #A. Or you can click on the "None™ button
or type #EN to deselect all your fonts.

Note: If the file does not contain any bitmap fonts that have related
outline fonts, the list will be empty.

+  When you have finished selecting fonts from this folder, click
g+
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The font name(s) you select will then appear in the Meta Pro "Fonts
to Convert” list,

Fonts to Convert

Garamond-Boldltalic <P

__&

You can continue adding fonts by repeating the previous procedure
or you can begin generating your fonts now.

Removing fonts

After you have selected your fonts for conversion, and you decide vou
do not wish to generate a particular font, you may remove it from the
font conversion list. Removing fonts from the font conversion list is
very simple.

+  Click on the font name to select it.

+  Choose "Clear” from the Edit menu or press either the clear key
or the delete key.

Note: This will not affect your currently saved or installed fonts.

METAMORPHOSIS Professional 39




Choosing Output Formats

Now that your "Fonts to Convert” list contains a complete list of all the
fonts you want to convert, the next step is to choose the "Output
Format” and "Computer Type" options.

Computer Type
Dutput Formats Mac PC NexT

Tupe 1 PostScript® | [ [X
Type 3 PostScript® a Y
TrueType™
PICT file ki
EPS file

Fontographer file

Ten output formats are provided in the "Convert fonts” mode. You can
select any of these options.

To select an option:
+  Click on the option’s checkbox.

An "X" indicates that the option is selected.

To deselect an option:

«  Click on the checked option box to deselect it.
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Output Formats
Type 1 PostScript

These options are provided to generate Type 1 PostScript language
fonts for the Macintosh, IBM-compatible PCs, and NeXT computers.

Mac

Metamorphosis Professional generates an ATM-compatible standard
Macintosh Type 1 PostScript language font file with hints. This font file
can be used for both automatically downloadable fonts or fonts that are
to be downloaded to the printer's hard disk.

A converted GoudyOldstyle Type 1 Macintosh font will be named
"GoudyOld” and look like the icon below.

A

;:
Goudy01d
Meta Pro automatically generates an "AFM" file which is named and
looks like the icon below.

Goudy Oldstyle. afm

Whenever you generate Type 1 or Type 3 fonts, Meta Pro automatically
generates an Adobe Font Metrics (AFM) file. This is a file for storing
font metrics information in TEXT format (font metrics include charac-
ter widths, kerning pairs, and character bounding boxes). Certain text
handling programs use this file. Additionally, Fontographer 3.2 can use
this tile to import kerning pairs into a font. Install it only if specified by
applications which require it. Otherwise, you may ignore the AFM file.
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Note: Since it is possible to generate both Type 1 and Type 3 PostScript
fonts at the same time (and they have the same naming rules), Meta-
morphosis will add a " to the file that is generated last to avoid nam-
ing conflicts. Therefore, if you generate Type 1 and Type 3 fonts for
GoudyOldstyle, the PostScript files will be named "GoudyOld™ and
"GoudyOlds" respectively. You must change the name before you install
it by removing the "+ at the end of the tont name. You can determine
which file is which by examining each file's icon. If you converted a
True Type font. Meta Pro will automatically generate a standard suitcase
file. In our example. it would be named "GoudyOldstyle. bmap.”

PC

Meta Pro generates standard PC Type 1 PostScript language fonts
which are compatible with Adobe Type Manager (ATM) running under
Windows 30 on IBM-compatible personal computers (PCs). Meta Pro
automatically generates an AFM file and a PFM file which are used on
the PC. All PC files adhere to PC font naming conventions.

A converted GoudyOldstyle Type 1 PC font will generate two files
named "GOO PFB" and "GOO PFM." If you have Apple
File Exchange on your disk they will look like the icons below.

10101 10100
GO0 PFB GO0 PFM

If you don't have Apple File Exchange on your disk, your icon will look
like the generic blank page icon below.

“l

GO0 PFE

The "PFB" at the end of the font name stands for Printer Font Binary
and represents a PC Type 1 font.

The "PEM" at the end of the font name stands tor Printer Font Metrics
and represents a PC Type 1 tont metrics file.
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Meta Pro also generates an "AFM" file named "GOO AFM’
which looks like the icon below.

R
=
Tefs
£ 2

GOO .AFM

Note: If you already have a PC font file for GoudyOldstyle in the
folder that you generate to, Meta Pro will name your new files
"GOO PFBe.” "GOO____ PFMs," and "GOO AFMe." Be-
fore you can use the PostScript font file on the PC, vou must remove
the "+" extension on the end of the file name. Additionally, if two of the
PC fonts you are converting have the same name, Meta Pro will put
the "*" after the second one it generates. Before you install this font on
the PC. you must rename the second PFB and PFM files so they are
distinguishable from the first font. Naming PFB and PFM files is totally
arbitrary so you can name them anything you like, as long as the last
character before the period is an underscore.

PC File Naming Conventions

Naming of PC font files is somewhat different than other naming
conventions. Once you understand how these names are created, you
can usually determine what the font name will be, based on its file
name. PC files have cryptic names consisting of eight characters which
are followed by the file extension type. The font file names are created
as follows:

Take the first two characters of the font name. In the case of

GoudyOldstyle, they are "GO." If the font was Palatino Bold Italic.
the first two letters in the file name would be "PA

The next five letters of the file name are composed of the remaining
uppercase letters from the font name in the order of their appearance.
This would make the name for GoudyOldstyle be "GOQQ." If the
font was Palatino Bold Italic, the first four letters in the file name
would be "PABL”
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Underscores represent remaining free spaces. Therefore. Goudy
Oldstyle would be named "GOO____" followed by the extension
name. The font Palatino Bold Italic would be named "PABI__~
tollowed by the extension.

The eighth character must always be an underscore.

The extension names are based on this table.

PC Naming Conventions Table

i ey

Type 1 font PFB
Type 3 tonts PFA
AFM File AFM
Metrics File PFM

Example: A Type 1 font generated from "GoudyOldstyle” would be
called "GOO _____ PFB.” A Type | font generated tfrom Palatino
Bold Italic would be "PABI PFB."

An AFM file generated from "GoudyOldstyle” would be called
"GOO AFM.” An AFM file generated from Palatino Bold
Italic would be "PABI AFM.S

Note: We want to emphasize (and deny any responsibility for thinking
up something this confusing!) that Altsys adheres to standard PC
naming conventions when Metamorphosis Professional assigns names
to PC font files.

For information on how to install your fonts onto a PC disk using
Apple File Exchange, refer to Altsys' Font Installer Guide.
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NeXT

Meta Pro generates a Type 1 PostScript font file that can be used on
NeXT computers.

A converted GoudyOldstyle Type 1 NeXT font will be named
"GoudyOldstyle NeXT" and look like the icon below.

GoudyOldstyle MexT

Meta Pro automatically generates an "AFM" file which is named and
looks like the icon below,

GoudyOldstyle.afm

Note: If you already have a NeXT file for GoudyOldstyle in the folder
that you generate to, Meta Pro will name vour new files

"GoudyOldstyle NeXTe" and "GoudyOldstyle. afme.”

Important: Before you can use the PostScript font file on the NeXT,

you must remove the "NeXTe" extension on the end of the file name
and the "o after the AFM file name.
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Type 3 PostScript

This option is provided to generate Type 3 PostScript language fonts for
the Macintosh and IBM-compatible PCs. Type 3 fonts can contain
stroked and filled characters. They can be utilized by programs like

Broderbund TypeStyler and Quark XPress and can also be useful for
PostScript clone printers that don't understand Type 1.

Note: Type 3 PostScript language fonts will not be hinted. If you wish to
apply hints, you can use Fontographer version 3.2 which can apply Type
3 PostScript hints for screen and printer fonts automatically,

Mac

Metamorphosis Professional generates a standard Macintosh Type 3
PostScript font.

A converted GoudyOldstyle Type 3 Macintosh font will be named
"GoudyOld” and look like the icon below.

€D

o1 . =

Goudy O1d

Meta Pro automatically generates an "AFM" file which is named and
looks like the icon below.

Goudy 01ldstyle_afm

Note: Since it is possible to generate both a Type 1 and Type 3 PostScript
font at the same time (and they have the same naming rules), Metamor-
phosis will add a "+ to the file that is generated last to avoid naming
conflicts. Therefore, if you generate a Type 1 and Type 3 font for Goudy
Oldstvle, the PostScript files will be named "GoudyOld” and "GoudyQOlde"
respectively. You must change the name before you install it by remov-
ing the "»" at the end of the font name, or the printer will not be able to
find the font.
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[f you converted a TrueType font, Meta Pro will automatically generate
a standard suitcase file. In our example. it would be named

"GoudyOldstyle bmap.”

PC

Metamorphosis Professional generates a standard PC Type 3 PostScript
language font. The PC file adheres to PC font naming conventions.

A converted GoudyOldstyle Type 3 PC font will have two files named
"GOO PFA" and "GOO PFM." It you have Apple File Ex-

change on vour disk they will look like the icons below.

101G

FFA GOO PFM

GOO

If you don't have Apple File Exchange on your disk. your icon will look
like the generic blank page icon below.

GOO PFA

The "PFA" at the end of the font name stands for Printer Font ASCII.
This file contains only standard ASCII characters.

The "PFM" at the end of the font name stands for Printer Font Metrics.

Meta Pro automatically generates an "AFM" file which (for

GoudyOldstyle) is named "GOO____ AFM" and looks like the icon
below.

R P
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Note: If you already have a PC file for GoudyOldstyle in the folder
that you generate to, Metamorphosis Professional will name your new
files "GOO PFA«" "GOO PFMe." and "GOO AFMs”
Before you can use the PostScript font file on the PC. you must remove
the "s" extension on the end of the file name.

For more information about PC font file naming conventions. see 'PC
Font Naming Conventions” on page 44. For information on how to
install your fonts onto a PC disk using Apple File Exchange, refer to
Altsys” Font Installer Guide.

TrueType

This option is provided to generate TrueType fonts for the Macintosh
and IBM-compatible PCs,

Mac

Metamorphosis Professional generates a standard TrueType suitcase file
which may contain all of the bitmaps in the original font. Bitmaps will
only be included if this option is checked in the "Preferences” dialog
(See page 57). This file will contain the TrueType SFNT (Scaleable
FoNT) resource file.

A converted GoudyOldstyle font will be named “GoudyOldstyle suit’
and will look like the icon below,

Al

Goudy Oldstyle suit
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PC

Meta Pro generates a TrueType file which is compatible with versions
of Windows which support TrueType. The "TTF" at the end of the font
name stands for TrueType File.

Lok o BTN g g g

For information on how to install your fonts onto a PC disk using Apple
File Exchange, refer to Altsys' Font Installer Guide.

PICT file

The "PICT File" option is provided to generate PICT format files for
the whole font. Meta Pro creates an object-oriented PICT that stores
the points and paths of the characters for use in drawing programs. If
you don't want to convert the whole font into a PICT file, you can use
the "Convert text” mode to convert just a few characters.

Programs such as MacDraw and MacDraw 1l. Canvas, Claris CAD,
DeskDraw, and Aldus FreeHand can read this file format directly for

editing purposes. So now you can reshape or distort vour characters,
change the line size, or fill them with specific colors or patterns.

Note: PICT outlines are not always absolutely identical to their PostScript
counterparts; there is a small amount of approximation involved in the

conversion. For more information about PICTs, see page 29

When you generate a PICT file, Meta Pro automatically creates a file
name based on the font name you are converting. So if you are convert-
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ing the font GoudyOldstyle, Meta Pro will choose the name
"GoudyOldstyle pict” and it will look like the document icon below.

N E

GoudyOldstyle pict

Note: If you already have a PICT file named GoudyOldstyle.pict in the
folder that you generate to, Meta Pro will name your new file
"GoudyOldstyle.pict*” so that you don't overwrite (erase) the old file.

EPS file

Mac

The EPS option generates Adobe Illustrator 1.1-style EPS (Encapsulated
PostScript) format files. Programs such as Aldus FreeHand and Adobe
[llustrator can read the EPS file format directly for editing purposes.
And once you open your EPS file, you can add or delete points, reshape
or distort characters, change the stroke weight, or fill characters with a
specific color or pattern. You can even alter a character’s shape to
create swash caps. If you don't want to convert the whole font into an

EPS file, you can use the "Convert text’ mode to convert just a few
characters.

When you generate an EPS file, Meta Pro automatically creates a file
name based on the font name you are converting. So if you are convert-
ing the font GoudyOldstyle, Meta Pro will choose the name
"GoudyOldstyle.art” and it will look like the the Adobe Illustrator 1.1

document icon below.
4]

GoudyOldstyle art
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Note: If you already have an EPS file named GoudyOldstyle in the
folder that you generate to, Meta Pro will name your new file
"GoudyOldstyle.arte” so that you don't overwrite (erase) the old file.

The illustration below shows a converted font that was generated in
EPS format and then opened using Aldus FreeHand's "Open file..."
item from the File menu. The letters "A” through "D" are selected. All
the points and BCPs can be activated and are ready for use. All the
functionality of FreeHand can be applied to your outlines.

Times.art

T4|5(0[0
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The illustration below shows a converted font that was opened using
Adobe Illustrator 88. The letters "A” through "D" are selected. The small
'x's” that appear between the characters allow you to line up the letters
to comply with their origin and width point markers.

E . IO e

| ARCDEFG
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METAMORPHOSIS Professional 51



52

Fontographer file

Mac

This option is provided to generate Fontographer database files that
can be edited in Fontographer 3.2, Altsys’ professional font creation
program. By combining this option with Fontographer, you have the
additional capability of customizing your own professional fonts.

A converted Goudy Oldstyle font will be named "GoudyOldstyle fog”

and look like the icon below.

GoudyOldstyle fog

Note: 1f you already have a Fontographer file for GoudyOldstyle in the
folder that you generate to, Meta Pro will name your new file

"GoudyOldstyle foge.”

And by using Meta Pro, Fontographer users can now edit their True'Type
fonts. Simply convert the TrueType font into a Fontographer file with
Meta Pro, edit the font in Fontographer, generate a Type 1 font, and
then use Meta Pro to change it back into TrueIype!
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When you open this file with Fontographer, it generates a 24-point
bitmap for its font window. You will then see the standard font window
that contains the complete font.

EOE===—====—=—====== Goudy0idstyle.fog
ObDec QHex Q0ct QOWidth OTint O Weig

You will now be able to utilize all the features of Fontographer to tweak
and manipulate the original outlines of your fonts

Converting fonts

Once you have selected your "Output Formats” and "Computer Types,”
there is only one thing left to do: Convert your fonts.

To convert fonts:

+  Choose "Convert. .."” from the File menu or type 3#G.

Open font file... %0 |
Open installed fonts... 3F

Preferences... ¥P
Convert... *
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OR

+  Press the "Convert. . .” button in the upper right hand corner of
the window.

sional ==a—————1I"]
[Ennuert... 336]

Fonts to Convert

vFont 4

Metamorphosis Professional gives you the option of determining where
you would like to store your new fonts.

|ﬁ HH Greatest Software

™ Metamorphosis Professional c Hard Disk
O Fontographer et )
[ The Art Importer Je

O Family Builder
O Fontastic Plus
2 Aldus FreeHand

[  Drive | |
(New Folder|
| Save |
| Cancel |

Choose where to save your new fonts:
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If you press the "New Folder” button, Meta Pro will allow you to create
a completely new folder and determine where you would like it to be
placed

Name of new folder:

Metamorphosis fonts

Cancel | | Create |

Once you have chosen where you wish to store your fonts, a dialog box
shows which font is being generated. A progress bar shows how the
current font conversion is progressing. The pie graph on the right
shows what portion of the overall font conversion process has completed.

=———— (owertingfonts ==

Reading “Times-Roman” (Typel) from disk.

P stop_.)

Meta Pro will clear fonts from the "Fonts to Convert” list as they finish
converting. You can cancel the conversion process at any time by
pressing the "Stop” button in the progress box or by pressing the
command key and typing a period. Doing so does not get rid of any fonts
that have already been generated, or remove any fonts from the "Fonts
to Convert” list, but it does stop any further generation.

When you finish converting fonts, you can convert more fonts, change
to the "Convert text” mode, or quit Meta Pro.

Note: If you generate a batch of fonts, the font generation procedure
could be lengthy. If you are running MultiFinder or System 7, you can
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work on other projects since Meta Pro will run in the background. If
you aren't running MultiFinder or System 7, you might want to select a

batch of fonts and generate them all at once, during a lunch break, or
maybe even overnight.
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CHAPTER FOUR

The "Preferences” option allows you to control different aspects of the
CONVErsion process.

=== preferenes E—am——"

| ‘f': General preferences: ,- )
[ Correct bad path directions
" ] Read fonts from the printer

Type 1 font preferences:
Apply hints

TrueType™ preferences:
[<] Apply vertical and horizontal hints
[ Apply diagonal hints
[<] Include original bitmaps
[ ] Separate font families

Dropout prevention:
() None @ Standard ) More
Character mapping:

@ Standard character ordering
(O Sequential character ordering

You access the "Preferences” dialog by choosing “Preferences...” from
the File menu.

Open font file... #®0
Dpen instabied Tants.., xF§
Lonvert fonts... ! LN
Quit #0
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General preferences:

The "General preferences” option provides control over some aspects
of the Metamorphosis conversion process.

Correct bad path directions

Characters consist of open and closed paths. When you print a charac-
ter on a PostScript printer, the printer fills the outline of the character
with a solid fill. This standard PostScript filling technique is called a
winding number (or normal) fill. In this type of character, one path
direction should be clockwise while the other should be counterclock-
wise. If both paths are going in the same direction, you will have
characters with improper fills like the "O” shown here.

You can correct this by reconverting your font with the "Correct bad
path directions” option checked.

(<] Correct bad path directions

This ensures that parts of characters which should be holes actually are
holes,
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You can turn off "Correct bad path directions” if you are converting an
Adobe Type 1 font since these usually have correct path directions, If
you are sure that your path directions are correct, you can turn this
option off to save time. If you have a font that has a problem with path
directions (or you just aren't sure), you should turn this option on.

Note: Path directions cannot be corrected in Type 3 fonts drawn with
overlapping paths, incomplete paths, and points on top of each other. If
you have Fontographer 3.1 or later, you can create and open the fog file
and make the necessary corrections to the problem paths.

Read fonts from the printer

This option tells Meta Pro to look into the attached printer's RAM,
ROM, or disk for the PostScript information when it doesn't find the
font it wants on your hard disk.

You should uncheck this option if you don’t have a PostScript printer
attached or you only want Metamorphosis Professional to read fonts
from your System and not automatically go to the printer to look for
them.

You can also turn oft "Read fonts from the printer” if you know that you
will never need outlines from your printer or your printer's hard disk.

Type 1 font preferences:

The Type 1 font preferences option provides control over some aspects
of the Type 1 conversion process.

Apply hints

~ You should leave the "Apply hints” option checked most of the time.
Exceptions would be in cases where you have a really weird font like
“Zapt Dingbats” that would not be improved by having hints. When in
doubt, you should leave hints on.
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TrueType preferences:

60

The "TrueType preferences” option provides control over some aspects
of the TrueType conversion process. You can select the type of hints
that will be used to instruct the character, select whether or not
bitmaps associated with the input font are copied to the TrueType font.
and select the amount of dropout control that is to be used when the
characters are imaged. Each of these preferences is explained in the
following paragraphs.

Apply vertical and horizontal hints

When a character, or “glyph.” is to be displayed on a screen or printed,
its outlines are scaled to the size required by the resolution of the target
device which is measured in dots per inch (dpi). If this scaled outline
were to be displayed or printed without modification, the result might
not be very pleasing. This is because the scaling of the outline by itself
does not take into account where the individual dots or pixels will be
drawn. Because of this, a vertical stem of a character, for example,
might fall between pixel boundaries and not show up at all on the
screen. To prevent problems like that, each glyph can have a set of
instructions which are used to fit the character to the grid of pixels for
a particular device. These sets of instructions are known as hints. After
the hints have been applied to a glyph, its outline is actually distorted.
but in such a way as to conform to the underlying grid so that the
important features of the character will be drawn correctly. The follow-
ing diagrams illustrate how hints improve the appearance of Truelype
characters.

Note: Don't be afraid to play with the different TrueType hinting
options. Rather than give you a "you want hints, you got hints" ap-
proach, Meta Pro provides you some control over how the hints are
applied. If you have created a TrueType font, and you don't think it s as
it ought to be, try using the drop-out control (see page 63). or turn
diagonal hints off. With a little experimentation, you can sometimes
wind up with a substantially better TrueType font.
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L] Apply hints

B e
s, S e
Unhinted outline Bitmap from unhinted outline

(< Apply hints

g SBE vy

e Y sy

Hinted outline Bitmap from hinted outline

The TrueType instructions for each character are based on identifiable
character features. Stems and serifs are the two most common character
parts which benefit from vertical and horizontal instructions.
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Apply diagonal hints

Characters such as "A” and "V" have diagonal stems which are impor-
tant character features. Normally the best results can be obtained by
applying both vertical and horizontal hints as the TrueType font is
converted. There are some fonts, however, which may look better it
one or both of the hint types are not used. Japanese and Chinese
characters, for example, often have a large number of conhtours. This
can result in "over-hinted” characters. If your font doesn't convert well,
try setting the preferences so that diagonal hints are not applied.

You may want to generate a IrueType font composed of unhinted
outlines. This is accomplished by setting the preferences so that neither
vertical, horizontal, nor diagonal hints are applied. In most situations,
you will need to add instructions to the font using some other method.
Otherwise the results on the screen and the printer are not likely to be
satisfactory.

Include original bitmaps

Bitmaps exist for many fonts. The default setting is to include these
with the TrueType font as it is generated. When a TrueType font is
being displayed on the screen and a bitmap for the current point size
exists, the bitmap is used. Using bitmap characters for screen display is
faster since the character does not have to be scaled and converted
from an outline. The results are usually superior because the bitmaps
are hand-edited for each point size. There are times, however, when
the TrueType outlines provide a more regular transition from one point
size to another. If you do not want to include bitmaps with the TrueType
font, turn off that option in the preferences dialog.

Separate font families

If you select this option, Meta Pro will split up your font famlies. If you
leave it unchecked (which is the default), Meta Pro will preserve your
families. This means that when you convert all four Times styles to
TrueType, for example. Meta Pro will create one file which will have all
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tour TrueType fonts stuffed into it (and still logically connected as they
were before). This is the option that most people will choose.

Altsys’ Style Merger allows you to merge separated fonts back into one
family. You can read more about Style Merger on page 76,

Dropout prevention

A "dropout” occurs when both sides of a character's line or curve fall
between pixel boundaries. A dropout is said to have happened when an
important feature of a character fails to appear at all. Meta Pro pro-
vides three levels of dropout control. If you select "None.” the TrueType
Fontscaler will not attempt to find and correct dropouts. "Standard”
dropout control will eliminate nearly all dropouts. "More” will eliminate
all dropouts but will sometimes turns on bits which weren't wanted.

The following illustrations show the results obtained using the three
levels of dropout prevention. The first “F" character is Missing its Cross
bar because it happens to fall between two pixel boundaries. With
“Standard” dropout prevention, the feature is restored.

No dropout control ~ Standard dropout control More dropout control

Notice that the outline at the right side of the top bar descends below
the bar. This type of structure is called a "stub.” The character would
conform to the intended outline better if a pixel were turned on in this
area. Standard dropout prevention will not find stubs. The third char-
acter was drawn with "More" dropout prevention. [t obviously has too
many pixels turned on. Due to a quirk in the TrueType Fontscaler, the
pixel that is turned on is to the left of the end of the bar. It is likely that
future revisions of the Fontscaler will not exhibit this behavior.
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Character mapping
Standard character ordering

Most of the time. you will never change the default, which is "Standard
character ordering.” Choosing this option gives you a normal font with
all the characters you would expect, in the places detined by Apple tor
a standard TrueType font.

Sequential character ordering

"Sequential character ordering.” on the other hand. means that in the
generated TrueType. characters are stored in the same order as they
were defined in the original font. This is useful for foreign character
sets. and other non-standard fonts. Because of the marginal use of this
setting. you will not encounter it very often.
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Appendix A

etamorphosis Professional is a unique utility that has the ability to
communicate with an attached PostScript printer that has an Adobe
PostScript interpreter. It executes special commands that allow it to
extract and send a font's true outlines back to your Macintosh.

How does Meta Pro do this?

. First it looks for the PostScript font in the folder where your
bitmap fonts are stored.

2. If Meta Pro doesn't find the outlines there, it then looks into the
tolder that contains the Metamorphosis Professional application.

3. The next place Meta Pro looks for the fonts is in your own System
folder. If you have installed your bitmap font using Font/DA Mover.
Suitcase, or Master Juggler, and have placed the associated PostScript
file into your System folder, Meta Pro will find it.

Or you can have your fonts installed another way: in their own
folder. We recommend that your bitmap fonts and your outline fonts
be stored in the same folder.

If. after the first three steps, Meta Pro has found the required
information, it sees if it can read the file directly from the disk. If it
cannot understand the tont file, it downloads it to the printer.

4. 1t Meta Pro fails to find the font file in any of the first three places,
it then looks into your attached printer's RAM or ROM for the
PostScript information. If Meta Pro doesn't find it there, it proceeds
to look in your printer’s hard disk (if there is one attached). If Meta
Pro fails to find the PostScript information in any of the above
mentioned places, you will not be able to convert the font.

METAMORPHOSIS Professional 65



66

[f there are any fonts left in the "Fonts to Convert” list at the end of
the conversion process, they have not been converted. You can
double-click on each font to read the associated error message.

Note: If you don't have an Adobe PostScript printer. your Type 3
fonts often won't convert. A few Adobe PostScript printers do not
support Meta Pro’s reading character outlines from them. So far
they are the QMS PS-410. any Emerald RIPs, the Epson EPS-7500.
and many other non-680x0-based RIPs from Adobe. Additionally.
fonts created in early versions of Fontographer (1.x) and Bitstream
Type 3 fonts must have a printer attached in order to convert. As
far as we know, Meta Pro can read fonts from all PostScript level 2
printers.

We're sorry but we cannot convert fonts that were created with
The Art Importer. Art Importer fonts stretch the font format farther
than Meta Pro can go.

Important: Please remember that Metamorphosis Professional was
designed to allow you to manipulate and edit vour own fonts for
your personal use only. Using Meta Pro to convert fonts for
commercial use is not only unethical but illegal. If you are considering
altering another company's font for commercial use, Altsys
recommends that you have their permission.
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Appendix B

When using MultiFinder, you can run Meta Pro in the background. We
have tound it extremely easy to generate a group of fonts while working
on other tasks. The progress dialog will always keep vou informed
while Meta Pro continues its conversion in the background, and will
beep when it is done,

If you are not using MultiFinder or System 7, it would be helptul and
save time if you select a batch of fonts for group conversion. Then you
can start the conversion process before you go to lunch or even before
you leave your office for the evening. In this way. the fonts will be
converted when you return (depending on how quickly you can eat or
how much or how little sleep you require!).

TrueType hinting and non-Roman fonts

The TrueType hinting options that are included in the Preferences
dialog should be turned off if you are converting non-Roman fonts (i.e.,
Zapt Dingbats). Applying hinting options to these fonts can make them
look extremely weird.

Converting PC Fonts

Metamorphosis Professional can't read PC fonts directly, so it needs to
use the printer. In addition. Meta Pro can't use an outline file without
having a bitmap file. So. in order for Meta Pro to extract a PC font
trom the printer, you must first create a "dummy” bitmap font file, using
Fontographer. Go to Fontographer's file menu and choose "New font "
Accept all the default sertings and click "OK.” Now "Save” the font into
the Fontographer folder with a name that is exactly the same
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as the embedded name in the font file to be extracted (i.e.. the font
name on the status printout). Next, choose “Generate fonts..." from the
File menu and choose "None" for the Outline format (we don't need a
PostScript file) and "Macintosh NFNT" for the bitmap tormat. Click
"OK” in the "Generate fonts..."” dialog and Fontographer will generate a
file named "YourFontName bmapfile” in the Fontographer tolder. Now
"Quit” Fontographer.

Next run Meta Pro. Use the "Open font file..." command to open the
bitmap font you just generated, and press the convert button. It vou
named the font correctly, and if the font is in the printer, Meta Pro will
read it directly from the printer.

PostScript fonts may override your TrueType fonts

Given a choice of outlines to print with, the Macintosh will always
choose PostScript over TrueType. For example. suppose you convert
Times from PostScript Type 1 to TrueType. You install your TrueType
font and try to print to a PostScript printer. Your document prints OK,
but the printer really used the PostScript Times font which is embed-
ded in your printer, rather than the TrueType version. The same thing
goes for the PostScript fonts which are on your hard disk. You should
rename your original PostScript font files if you want to be sure that the
final printout is actually TrueType.

Symbol characters

We apologize for the “techeze” in this tip, but here goes: Meta P’ro pulls
in Symbol characters for typefaces encoded with the Macintosh encod-
ing vector. At the start of the conversion process, you may notice that
sometimes Meta Pro will begin by reading in the Symbol font. This is .
because you have chosen some fonts which need Symbol characters.

Fontographer database with attached library

Do not attempt to convert a Fontographer database which has an
attached library. Use Fontographer to generate a PostScript font and
then convert that font instead of the database file
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Appendix C

‘I'erm

The Macintosh uses bitmap fonts for screen display and printing to
bitmap printers. Bitmap fonts are selected from any application which
understands fonts. These fonts are stored in the System file or in
suitcase files, where they are accessible to all programs. Bitmap fonts
cannot be smoothly scaled, so each font requires several bitmap fonts in
different sizes for display purposes.

The bitmap fonts used for screen display are automatically tied to the
PostScript tonts by the font name and size. For example, when a
document which uses a bitmap font called Garamond-12 is printed to a
PostScript printer, the print software looks for a PostScript font named
Garamond. The font size is passed on to the PostScript font as a scaling
factor.

Caching

Translating an outline character into a bitmap is a complex process
which takes an amount of time proportional to the complexity of the
character. To minimize the amount of time spent generating bitmaps
from outlines, the bitmaps are saved for later use. This saving process is
known as caching. The first time a particular letter is printed, its bitmap
must be generated and cached before it can be drawn on the page.
Once a letter has been converted, its bitmap is normally found in the
cache, and is used directly.
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Downloading

EPS

Downloading is the means by which the font outlines are sent to the
printer from the Macintosh. This normally occurs over an AppleTalk
network.

LaserWriters contain powerful computers which allow them to accept
a variety of fonts and graphics commands that are expressed in PostScript
or TrueType. In particular, the LaserWriter can accept new typefaces
through the process of downloading.

The LaserWriter has two important types of built-in memory. The first
is ROM (Read-Only Memory) which is unchangeable. ROM holds its
information indefinitely, even when the power is turned oft. The basic
printer control program and several typefaces are programmed into the
ROM and thus are not changeable. The second type of built-in memory
is RAM (Random-Access Memory), which can be changed. However,
RAM loses its contents each time the power is turned off. Downloaded
fonts are put into RAM or onto a hard disk attached to the printer.

EPS (sometimes known as EPSF) is the Encapsulated PostScript file
format originally developed by Altsys Corporation. EPS files may also
contain a PICT (bitmap) representation along with the PostScript de-
scription of a picture,

A FOND is a Macintosh file resource that contains (among other
things)the information that creates the link from the bitmap font to the
PostScript font. The Macintosh print manager examines the FOND to
find the name of the corresponding PostScript file. If there is a PostScript
font file available in the System Folder, it is downloaded to the printer
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before printing begins. If no PostScript font file is found, and there are
no TrueType outlines available, or if the FOND does not exist the
bitmap font is used. The PostScript font file must be in the System
Folder or in the same folder as the printing application in order to be
found for downloading (unless you are using Suitcase Il or Master
Juggler).

Font

A font (which is derived from “found” as in typefoundry) of type tradi-
tionally is a complete set (or alphabet) of type in one size and style (for
example, 12-point TimesBold). A typeface (or face) is a complete set of
characters and styles which share a similar appearance.

With computers. the term “font” has come to represent a family of type
which includes all the sizes and styles. Additionally, the distinction
between fonts and faces is not always clear-cut. For example, the Times-
Roman face comes in several sizes of screen fonts but inside the
LaserWriter there is only one master face which is automatically scaled
to the desired point size during printing. Since the distinction between
face and font is not clear, we feel justified in using the term “font” to
describe both a particular size of a face, and the underlying face itself

Hints

Hints are special instructions that font outlines use to make themselves
look good at small sizes (i.e. 12 points) on low-resolution devices like
the LaserWriter and your monitor’s screen (72 dpi). On high-resolution
devices (1200 dpi and higher) like the Linotronic, hinting doesn't make
any difference unless you're printing extremely small text (i.e., 2 points).
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PICT

PICT (taken from picture) is Apple's standard file format for bitmapped
and object-oriented graphics and is supported by most Macintosh
graphics applications. Using PICTs allows you to save graphic informa-
tion as a series of objects, like squares. circles. and freeform paths.
When a PICT file is reopened, all of that information is read back in,
and all of your graphics appear just as they did when you last edited
them. Meta Pro uses the PICT as a way to store character outlines as
freeform paths (that's "Smooth Polygons™ in PICT terms), so programs
which understand PICTs can get at them.

PostScript

PostScript is a programming language which was developed by Adobe
Systems, Inc. to drive high-resolution printers. Invented as a standard
page description language with a well-documented behavior, it is used
on a number of different manufacturers’ printers and typesetters.

PostScript's generality allows any picture to be described as a program;
this is how fonts are constructed. Each letter is described by a small
program which draws the letter outline using geometric primitives. In
order to print the character on a page, this character drawing program
is run by the printer control software to draw and fill the outline,
generating a high-resolution bitmap. The bitmap is generated at the
current point size, and then placed on the page at the appropriate
location.
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Typel

Type 1 fonts are a special kind of PostScript font, and may contain
hints. There are some advantages in using Type 1 fonts over Type 3
fonts.

Type 1 fonts are filled using a better technique, so they look more
like their actual outlines than Tvpe 3's do.

+ Type 1 fonts are more compact. since part of the font is built into
the printer.

Type 1 fonts are compatible with Adobe Type Manager., so that all
sizes can be rendered on screen smoothly.

Type 1 tonts print faster.

There are also a few disadvantages in using Type 1 fonts.

- Iype 1 fonts cannot contain external composite characters.
Type 1 fonts cannot contain grayscale filled characters.

Type 1 fonts cannot contain stroked characters (characters with no

fill).

» Type 1 fonts cannot work on some PostScript clone printers.

Type 3

Type 3 fonts, sometimes referred to as user-defined fonts, are the most
flexible and general type of PostScript font. Type 3 fonts have some
advantages over Type 1 fonts.

+ Type 3 fonts can contain complex composite characters.

Type 3 fonts can contain grayscale fills.
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Type 3 fonts can contain stroked characters.

Type 3 fonts work on PostScript clone printers that don't use Type 1
fonts.

TrueType

TrueType is the new outline font format developed by Apple Com-
puter to be used with their System 7 operating software. TrueType can
allow for fonts with more than 256 characters, so large character sets
(i.e. Kanji. Gaigi, etc.) will be supported. Some advantages in using
TrueType are:

TrueType has the potential to look better than Type 1 (especially at
sizes of 12 points and below) because it has a more capable hinting
scheme.

You don't need to use ATM to get a nice screen display of your

fonts since System 7 images TrueType fonts on the screen
automatically.

TrueType fonts are simpler to use than PostScript fonts since the
bitmaps and outlines are in the same file.

TrueType is an outline font format and character imaging system that
allows a single definition of a font, in the form of outlines, to be used at
various sizes and on different devices with different resolutions. A
TrueType font can be used for screen display and for output to a wide
array of printers. The same font can even be used on multiple computer
platforms.

Each character in a TrueType font is defined by its outlines and other
information such as its height and width. A single character definition
is known as a "glyph.”
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How TrueType works

Each TrueType glyph consists of one or more paths which are
always closed. That is, the last point, although it is not explic-
itly stored in the glyph, is the same as the first point in the path.
Each path is made up of straight lines and curved segments.
The curved segments are quadratic B-splines. A B-spline is
defined by two points, known as on-curve points, which define
the end points of the curve segment and a single off-curve
point which determines the curvature of the segment. A path
may have a number of these curved segments joined together
to form a continuous, smooth curve. In this case, only the off-
curve points plus the beginning and ending on-curve points
are stored as part of the glyph. The missing on-curve points
can be calculated as they are needed.

A character can also be defined by a component glyph. A
component glyph does not have any outline points of its own.
Rather, it defines the character by using the outlines from one
or more other glyphs, or components, Accented characters are
often defined as component glyphs.

When a character is to be displayed on a screen or printed, the
glyphs outlines are scaled to the size required by the resolution
of the target device measured in dots per inch (dpi). It this
scaled outline were to be displayed or printed without modifi-
cation, the result might not be very pleasing. This is because
the scaling of the outline does not take into account where the
individual dots or pixels will be drawn. Therefore. a vertical
stem of the character, for example, might fall between pixel
boundaries and not show up at all on the screen. This is where
hints become important. Each glyph can have a set of instruc-
tions, known as hints, which are used to fit the character to the
grid of pixels for a particular device. After the hints have been
applied to a glyph, its outline is actually distorted, but in such a
way as to conform to the underlying grid so that the important
features of the character will be drawn correctly. This is how
one set of outlines can be used on different computers and on
different types of printers.
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Appendix D

Style Merger

Wi have included our new utility, Style Merger™, on the Metamorpho-
sis Professional disk.
4" Style Merger takes styled fonts and merges them into one font family.
" Style Merger will work with both PostScript and TrueType fonts. It
never affects any fonts or font files on your computer; it simply reads
existing fonts and creates new files.

Style Merger allows you to quickly and easily build a tamily containing
Plain. Bold. Italic. and BoldItalic fonts. So if you use Meta Pro to
convert four style fonts of the same typeface. Style Merger ¢an merge
the four separate fonts into one family, thus saving space in your font
menu.

Style Merger is so easy to use that the complete instructions are
included on these three pages.

To start Style Merger:

Double-click on its icon.

L

=
=M
Style Merger 1.1

+  Choose the Plain font for your new family.

. Then choose which fonts should be the Bold, Italic, and Boldltalic

faces.
+  Save the new family.

That's all there is to it.

76 METAMORPHOSIS Professional



Style Merger's main window is mostly a collection of buttons. On the

left side of the window are the style buttons: Plain... Bold. .. Italic. .
and Boldltalic. ..

When you start Style Merger, the only button you can initially press
(other than "Help,” which is always available) is "Plain...” which begins
the process of creating the family. In addition, "Plain..." has a bold
outline around it, indicating that this is the button you should press
first. The button that you should press next always has a bold outline
around it, to guide you through the family building process (hitting the
carriage return always has the effect of clicking on the currently bolded
button). Buttons which you are not supposed to press at a particular
time are dimmed so that you can't press them and get into trouble. In
case you do make a mistake clicking "Plain...” always removes any
previously selected fonts and allows you to start over.

After you press "Plain...," a file selection dialog appears. allowing you to
choose your fonts. Say you choose Times-Roman, because that is the
Plain style of Times. Once you have made your selection, you will see
the name of your Plain font appear to the right of the "Plain...” button.
There is also a font file image there which changes from gray to black.
indicating that a Plain font has been selected. In addition, the default
new family name will appear just above the "Save Family...” button on
the right. This name can be changed when you press the "Save Fam-
ily...” button.

T —— e e S—

[ Plain.. | m‘rimn—ﬁman ; {
Ef‘"i Timeas-Roman.Tam

| Italic... | [L;ij ($oue Family... ]
[ Bolditalic... | [;ﬁ
L help... |

Once you choose your Plain selection, Style Merger puts a bold outline
around the "Bold...” button indicating that this would be a good button
to press next. You can choose the Bold, Italic, and Boldltalic styles in
any order you want, so you could choose “Italic...” next if you like. To
continue with our example, you should just click on the "Bold. ..~
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button and do them in order. Once you have selected the "Bold..."
button (or whichever button you choose second). the "Save Family. ..’
button becomes active since “technically” you have enough fonts to
create a family. You don't have to have all four styles to merge into a family.

When vou press the "Save Family...” button, a dialog box appears
asking you where you want to save the family and what you would like
to name it. In our example, Style Merger would suggest a name like
“Times-Roman fam.” This will be the name of the file it creates unless
you name it something different. When you install the new tamily, you
will see Times-Roman in your font menu. If you just want to see “Times
in the font menu, you should tell Style Merger to save the family as "Timesfam.”
After you press "OK" in the dialog box. Style Merger takes a moment or
two to actually build the family, saves it on the disk, cleans out all the
font selections, and is ready to build another family.

Things you should know

Font families must be built using fonts that are meant to go together
(i.e., their names must have the same base part). So. you cannot choose
Helvetica-Bold as the bold style in the Times family; you have to choose
a font whose name begins with Times.

Make sure the fonts you use to build families are not installed. Always
use SuitCase™, Master Juggler™, or whatever you installed them with
to close the fonts first. If you see the suitcase icons in Style Mergers
window change to capital A's or B's, that means that the font you have
chosen was already installed.

If you are using Adobe Type Reunion™, you'll probably want to keep
your font files separate. Merging them into one family prevents Type
Reunion from putting its little style popup menu next to that font in
your font menu. However, if you don't like having fonts spread all over
your font menu (grouped together under B's, and I's, and Bl's), Style
Merger is the answer. Style Merger can, for example, take Times, B
Times Bold, 1 Times Italic, and Bl Times Boldltalic, and build them all
into Times. Now, instead of changing fonts from Times to B Times
Bold. simply change the style to Bold.
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Appendix E

should know about PICT

Here 1s some additional information that vou might like to know about
PICT. If you are not interested in conversion to PICTs, you may skip
this section.

When you may need more memory

PICT to Clipboard and PICT file conversion need a lot of memory. If
you convert a normal” amount of text (thirty or forty letters). you
should never have to give Meta Pro more memory. However, if you
convert all the characters in the font at once, you may need more
memory, but even that depends upon the font

Reshaping PICT paths

We create PICT paths which have some extra points to give better
outlines. Depending on what you want to do with the PICTs, this may
or may not be a problem. Having lots of points in a path makes it
somewhat more ditticult to edit. If you are not planning on editing (i.e..
reshaping) the actual character paths in your drawing program, don't
worry about it. But it you are, here are some strategies to help minimize
the number of points:

+If your PICT was from a Type 1 font. try converting it to TrueType
first. then recreate your PICT from the TrueType font

+ If the only reason you would edit a character form is to make it
look better (because the conversion process didn't do such a hot
job on it), try generating the character at 300-500 points. then scale
it down in your drawing program. This almost always results in an
excellent conversion to PICT. and you won't have to edit it at all.
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If all else fails. you can delete points of paths in MacDraw Il and
MacDraw Pro. Select a character path, choose "Reshape” from the
Edit menu. then Option-click on the points you want to remove. If
the path changes slightly after you remove a point, grab an adjacent
point and adjust it until the path assumes its previous shape.

If you are going to Aldus FreeHand or Adobe Illustrator, don't use
PICT. Use EPS, which is a vastly superior graphics format.
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Appendix F

ys Product Line

Fontographer is a specialized graphics editor designed to simplify the
creation of high-quality PostScript typefaces, character sets. and logos
on the Macintosh. The fonts you create are ATM-compatible and can
be used on Macintosh, PC. and NeXT computers. With Fontographer
you can modify an existing character set, trace a scanned image, or
draw from scratch. You can create your own fonts, logos, or custom art,
and have them all available at the touch of a key.

Whether you are a novice or an experienced graphic designer,
Fontographer provides the means to assign your typographic images to
any key or combination of keys, and the added ability to instantly
repeat and resize these images in any application.

Using Fontographer's drawing tools, you can create a professional-
quality PostScript character in minutes and print that character on a
LaserWriter or any PostScript compatible printer.

EPS Exchange

EPS Exchange is the tirst software utility for the Apple Macintosh
which allows Aldus FreeHand 3.0 drawings to be easily and accurately
exported for use in Adobe Illustrator 88 and Adobe llustrator 3.0.

The tirst in the Altsys XTRAS line of software. EPS Exchange provides
a powerful design and productivity tool for art directors, freelancers,
service bureaus, ad agencies, and other creative types who create
illustrations with PostScript language drawing programs.
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EPS Exchange is simple to use: choose "Save as...” or "Export” from the
Aldus FreeHand File menu and then select either the Adobe Illustrator
30 or Adobe Illustrator 88 format. EPS Exchange automatically con-
verts the Aldus FreeHand 3.0 document to an Adobe I[llustrator docu-
ment.

With EPS Exchange. you can immediately begin to increase your flex-
ibility in creating PostScript illustrations, as well as your ability to
collaborate with your colleagues.

Fontastic Plus

Fontastic Plus is Altsys  specialized bitmap font editor designed to
create new bitmap fonts and typefaces and customize existing bitmap
character sets with distinctive characters, logos, and graphics.

Using MacPaint-like tools. you can easily create bitmap logos, foreign
characters, clip art, and custom fonts, Images can be cut and pasted
into a font from other applications (i.e., MacPaint). You can apply
special effects like scaling (up to 127 points), as well as rotating, styling,
and editing to provide a quick and easy way to design attractive fonts
and graphics.

An integrated font mover makes installing your fonts as simple as "Cut’
and "Paste.”

Fontastic Plus includes standard Altsys features such as kerning pairs,
fractional character widths, and multiple undo’s and allows for high-
quality printing on QuickDraw printers.

Aldus FreeHand

Aldus FreeHand, designed and written by Altsys Corporation, is a
powerful, precise, and easy-to-use PostScript illustration and design tool
for the Apple Macintosh. Like all Altsys products, Aldus FreeHand can
meet the demands of commercial artists and designers, yet is simple
enough for the average user. Aldus FreeHand is published by Aldus
Corporation. Contact Aldus at (206) 622-5500 for more information.
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Installing Meta Pro. 4
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definition, 74
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how TrueType works, 75
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